Eastside Hockey Manager™ Game Manual

Table of Contents

INTRODUCTION .......................................................................................................................... 4

1.1. What is Eastside Hockey Manager™? ............................................................................ 4
    1.1.1. A Welcome to New Eastside Hockey Manager™ Players! ...................................... 4
    1.1.2. A Welcome to Fans of Previous Versions of Eastside Hockey Manager™! .............. 4
    1.1.3. About This Manual ................................................................................................. 4

1.2. Installation and Licensing .............................................................................................. 4
    1.2.1. System Requirements ............................................................................................ 4
    1.2.2. Installing Eastside Hockey Manager™ ................................................................. 4

2.0 GETTING STARTED ........................................................................................................... 5

2.1. Launching the Game ....................................................................................................... 5
    2.1.1. The Main Screen .................................................................................................... 5
    2.1.2. The Game Preferences Screen ............................................................................... 6

2.2. The Create New Game Screen ....................................................................................... 7
    2.2.1. The Select Leagues Screen .................................................................................... 7

2.3. The Add Manager to Game Screen ............................................................................... 8

2.4. Game Management Screen Common Elements ............................................................. 9
    2.4.1. Titlebar and Menu Bar ......................................................................................... 9
    2.4.2. The News Button ............................................................................................... 9
    2.4.3. Navigation Arrows and Quick Flicks ................................................................. 9
    2.4.4. The Continue Button ......................................................................................... 10
    2.4.5. Quick Find ......................................................................................................... 10
    2.4.6. Menus/ Drop-Downs ....................................................................................... 10
    2.4.7. Report and Action Buttons ............................................................................... 10
    2.4.8. Filters .............................................................................................................. 11

3.0 THE OPTIONS MENU ..................................................................................................... 12

3.1. Save Game ................................................................................................................... 12

3.2. Add General Manager ............................................................................................... 12

3.3. General Manager Status Screen ................................................................................. 12

3.4. Detail Level ................................................................................................................ 12

3.5. Preferences ............................................................................................................... 13

About This Manual ................................................................................................................. 4

A Welcome to Fans of Previous Versions of Eastside Hockey Manager™! ...................... 4

A Welcome to New Eastside Hockey Manager™ Players! ........................................... 4

Installing Eastside Hockey Manager™ ............................................................................ 4

Game Management Screen Common Elements ............................................................. 9

The Add Manager to Game Screen ............................................................................... 8

Game Manual ..................................................................................................................... 4

Page 1 of 62
3.6. Selected Leagues ..............................................................13
3.7. Game Credits .................................................................13
3.8. Websites ........................................................................13
3.9. Exit Game .....................................................................13
4.0 KEY SCREENS..................................................................14
4.1. The Roster Screen..........................................................14
4.1.1. Roster Management ....................................................15
4.1.2. Contract Management ...............................................16
4.1.3. Reserve List ..............................................................16
4.1.4. Waiver Eligibility .......................................................16
4.1.5. Shootout Choices ......................................................16
4.1.6. Set Jersey Numbers ...................................................17
4.1.7. Set Team Needs .........................................................18
4.1.8. View Team Report ....................................................19
4.1.9. Compare Teams .........................................................20
4.1.10. Print ......................................................................21
4.2. Board Confidence ..........................................................21
4.3. Resign From Team ..........................................................21
4.4. Front Office ..................................................................22
4.5. News ...........................................................................23
4.6. Scouting ......................................................................24
4.7. General Manager Stats ..................................................24
4.8. Job Information .............................................................24
4.9. Transactions ..................................................................24
4.10. History .......................................................................24
4.11. General Manager Options ............................................24
4.12. Boxscores to Show .......................................................25
4.13. Go on Vacation .............................................................25
4.14. Scouting and Player and Staff Search Screen ..............25
4.15. The Change General Manager Menu .........................26
5.0 THE LEAGUE MENU..........................................................26
5.1. The League Screen .........................................................26
5.2. Scores & Schedules ........................................................27
5.3. Player and Team Statistics .............................................28
5.4. Transactions and Trade Center .....................................30
5.5. The History Screen ........................................................31
6.0 TACTICS .....................................................................32
6.1. The Tactics Screen ........................................................32
7.0 PERSONNEL .................................................................37
7.1. Practice ......................................................................39
8.0 SCOUTING ..................................................................40
9.0 THE PLAYER ATTRIBUTE MODEL ..................................42
9.1. Physical .....................................................................43
9.2. Mental .......................................................................44
9.3. Technical .................................................................45
9.4. Goaltending ...............................................................47
10.0 DRAFTS ....................................................................48
10.1. Scouting the Draft ......................................................48
10.2. The Draft Screen .........................................................49
10.3. Fantasy Draft .............................................................50
11.0 TRADES AND TRANSACTIONS .......................................51
11.1. Trading ....................................................................51
11.2. Waivers .................................................................54
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.3.</td>
<td>Free Agency</td>
<td>54</td>
</tr>
<tr>
<td>11.4.</td>
<td>Arbitration</td>
<td>56</td>
</tr>
<tr>
<td>12.0 FINANCES</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>12.1.</td>
<td>The Finances Screen</td>
<td>56</td>
</tr>
<tr>
<td>13.0 PLAYING GAMES</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>14.0 STATISTICS</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>15.0 TROUBLESHOOTING</td>
<td></td>
<td>62</td>
</tr>
</tbody>
</table>
Introduction

1.1. What is Eastside Hockey Manager™?

Every hockey fan at some time or another likes to think of themselves as a GM. Whether it’s a disagreement with a game night line-up, a roster decision, or off-season moves, there’s usually a time you’ll end up thinking “I can do better than that.” Well, you can. Eastside Hockey Manager™, from Sports Interactive, the sports management development specialists, gives you a chance to live out that dream.

Experience the very highest in realism and playability, and immerse yourself in your own world.

Build your own dynasty by signing free agents, wheeling and dealing with other owners, or by calling up that hot prospect from the minors. Watch your seasoned veterans skills slowly deteriorate and replace him with one of your top draft picks. It’s your world, but you can choose to extend that world to include your friends in a multiplayer league. Should you prefer it just between you and your computer then that’s absolutely fine. You’ve got something to prove to the hockey world and you’re not going to stop until you’re there.

1.1.1. A Welcome to New Eastside Hockey Manager™ Players!

If you’re starting your reading here, we’re assuming you’ve never played Eastside Hockey Manager™ before. So we’ll first recommend you read 1.1, and then continue here. Eastside Hockey Manager™ puts you in the position of a hybrid GM/Head Coach of a hockey team. You carry out the day-to-day business of a General Manager, and then come game time; you’re behind the bench, controlling every aspect of your roster, in search of the win. You’ll need financial acumen, an eye for talent, a strong patience, and above all, you’ll need the intangibles – the ‘it’ factor that winners have.

1.1.2. A Welcome to Fans of Previous Versions of Eastside Hockey Manager™!

To the guys and girls who’ve played previous incarnations of Eastside Hockey Manager™, welcome back! We’re sure you’ll not only be delighted to see the game return but that you’ll also find Eastside Hockey Manager™ better than ever. A brand new look will make your navigation around our game even more refined, and a whole host of new features, tweaks, and additions are sure to keep you coming back time and again, desperate for your hockey fix. Think you’ve mastered Eastside Hockey Manager™? Think again.

1.1.3. About This Manual

Whether a rookie or a veteran Eastside Hockey Manager™ player, we strongly recommend you start your Eastside Hockey Manager™ experience by walking through this manual. We really believe this. Honestly.

1.2. Installation and Licensing

1.2.1. System Requirements

PC
Minimum Requirements:
Microsoft Windows XP/Vista/7/8
Intel Pentium 3 Processor @ 1GHz or equivalent
256mb RAM
800mb Free Hard Drive Space

1.2.2. Installing Eastside Hockey Manager™
In order to purchase and install Eastside Hockey Manager™, follow the on-screen guidelines provided through Steam.

2.0  Getting Started

2.1.  Launching the Game

To launch the game, double click the exe icon or shortcut, or click ‘Play’ from within Steam.

The game will load through the various introductory and splash screens, and then arrive at the main screen.

2.1.1.  The Main Screen

The options on the screen have the following effect:

<table>
<thead>
<tr>
<th>New Career Game</th>
<th>Starts creating a new game.</th>
</tr>
</thead>
</table>

---

![Eastside Hockey Manager Main Screen](image)
<table>
<thead>
<tr>
<th><strong>Import Database</strong></th>
<th>Allows you to import a saved EHM database for use in a New Career Game.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load Last Game</strong></td>
<td>Allows you to load the last saved game.</td>
</tr>
<tr>
<td><strong>Load Game</strong></td>
<td>Allows you to load a previously saved game.</td>
</tr>
<tr>
<td><strong>Delete Game</strong></td>
<td>Allows you to delete an existing saved game.</td>
</tr>
<tr>
<td><strong>Start Network Game</strong></td>
<td>Allows you to start a saved game for use in Network play.</td>
</tr>
<tr>
<td><strong>Load Network Game</strong></td>
<td>Allows you to restore a saved game used for Network play.</td>
</tr>
<tr>
<td><strong>Join Network Game</strong></td>
<td>Allows you to join a Network game.</td>
</tr>
<tr>
<td><strong>Eastside Hockey Manager™ Community</strong></td>
<td>Links to assorted Eastside Hockey Manager™ websites and forums.</td>
</tr>
<tr>
<td><strong>Credits</strong></td>
<td>Game development and research credits.</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>Allows you to modify global game preferences.</td>
</tr>
<tr>
<td><strong>Quit</strong></td>
<td>Exits the game.</td>
</tr>
</tbody>
</table>

### 2.1.2. The Game Preferences Screen

The options on the screen have the following effects:

<table>
<thead>
<tr>
<th><strong>GAME</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Currency</strong></td>
<td>Allows you to play in a number of currencies.</td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td>Allows you to play in either European date format (dd/mm/yy) or North American (mm/dd/yy).</td>
</tr>
<tr>
<td><strong>Measurement</strong></td>
<td>Choose from Imperial (feet, yards) or Metric (centimeters and meters).</td>
</tr>
<tr>
<td><strong>Wages</strong></td>
<td>Allows you to view salaries on weekly, monthly, or yearly scales.</td>
</tr>
<tr>
<td><strong>Autosave</strong></td>
<td>Allows you to set the game to autosave at incremental intervals.</td>
</tr>
<tr>
<td><strong>Autosave Mode</strong></td>
<td>This section allows you to determine what, if any, type of autosave is implemented. You can choose to use a single file which is saved over each time, or a Rolling or Date-Stamped version. Rolling saves will create a maximum of three incremental saves, named saved game_1, saved game_2 etc, as well as retaining the original saved game file, whilst Date-Stamped ones will do as they say, include the date in the file name rather than the number.</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Allows you to choose which size database to load into your saved game. Naturally, should you have a PC which may not be up to the rigors of such a game, selecting Minimum will be of benefit.</td>
</tr>
<tr>
<td><strong>Games Stored</strong></td>
<td>Configures the number of games stored for you to be able to go back and look at in detail in future seasons. If a game is not stored, you will not be able to look at a boxscore for it. The game can also only store a maximum of 10,000 games, so should your saved game run for a considerable amount of time it will naturally store 10,000 recent games rather than those early in the save.</td>
</tr>
<tr>
<td><strong>Background Games</strong></td>
<td>This allows you to control the number of games which will be simulated simultaneously whilst you are coaching/viewing a game.</td>
</tr>
<tr>
<td><strong>Print To</strong></td>
<td>Set whether you would like your printouts to go directly to a printer, saved to a .txt file, both, or exported in HTML format.</td>
</tr>
<tr>
<td><strong>Save Compressed</strong></td>
<td>If checked, your saved games will be compressed when saving, freeing up valuable disk space.</td>
</tr>
</tbody>
</table>
### Save Safely
If checked, the game will save your game into a temporary location first before overwriting the old save file, ensuring your previous saved game stays intact should any problems arise during saving. Note that with this option, saving a game requires double the free disk space required for one saved game.

### Enable Media Hyperlinks
If enabled, you will be able to click media urls in news items and have them load in your designated internet browser. Please note, you must be connected to the internet for this to work.

### Disable Human Manager Sackings
If you wish to prevent the human manager from ever being fired, ensure that this option is ticked.

### Tutorial Screens
Toggle whether the in-game assistance of small guided tutorial advice is enabled or not.

---

### DISPLAY

<table>
<thead>
<tr>
<th>Skins</th>
<th>Select your choice of skin to use in-game from this menu. Skins can be physically located in data/skins, and should be put there in order to appear in this menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Game Clock</td>
<td>Set whether you wish the game clock to run Up from 0:00 to 20:00 (typically International style) or Down from 20:00 to 0:00.</td>
</tr>
<tr>
<td>Score Displays</td>
<td>Set whether you wish for scores to be displayed in European format (Home team first) or North American format (visiting team first).</td>
</tr>
<tr>
<td>Attribute Display</td>
<td>Set whether you wish for player attributes to be displayed in a 1-20 format, a 1-100 format or to be hidden from view altogether.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>If you wish to run the game in windowed mode this must be unchecked. Please also note, your desktop resolution must be greater than both 1024 pixels wide and 768 pixels high for windowed mode to be possible.</td>
</tr>
<tr>
<td>Profile Pictures</td>
<td>Set whether you wish for player photos to be present on the player profile screen.</td>
</tr>
<tr>
<td>News Images</td>
<td>If checked, appropriate and/or custom images will appear in context in news items.</td>
</tr>
</tbody>
</table>

### SOUND

| Play Sounds | If enabled, sounds will be played during games, enhancing the game day experience. |

### NETWORK/INTERNET

| Server Name | Set the name of your server used for hosting an online game of Eastside Hockey Manager™. |

---

### 2.2. The Create New Game Screen

When you start a new game, Eastside Hockey Manager™ brings you to the Create New Game screen. This screen has a lot of information, and can be pretty overwhelming even for experienced Eastside Hockey Manager™ players.

#### 2.2.1. The Select Leagues Screen
To select a league, simply tick the checkbox to the very left of the screen. To select the level of detail the league will be run in, simply change the dropdown in the far right column.

Eastside Hockey Manager™ provides two different types of leagues: View-Only Leagues, and Enhanced Leagues. Enhanced Leagues allow you to manage and participate fully in day-to-day life in that league, whilst View-Only will run the league using the ‘quick-sim’ game engine. At any time, you may make a View-Only League an Enhanced one from the ‘Select Leagues’ screen. Please note however, the league must be loaded as View-Only as a minimum when starting a new game for it to be changed during your career.

If you are noticing the general speed of the game becoming very slow or are making little progress it might be worth considering selecting fewer leagues or configuring detail levels. Fewer leagues require less processing and as such will allow the game to proceed more quickly.

Please refer to Section 3.4 for information on configuring detail levels amongst leagues you have selected once the game has been created.

The following are options on the Select Leagues screen:

<table>
<thead>
<tr>
<th>Select/De-Select All</th>
<th>Will automatically select all leagues as Enhanced. De-select All will remove all checked leagues.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Game Start Date</strong></td>
<td>Set which date you wish the game to start, based on each country’s first in-game date. Typically these will differ very little, but for example, you may wish to start a career in North America with a European start date, giving you more time before the season starts. Or perhaps vice-versa, managing in Europe with a North American start date to get you straight into the action.</td>
</tr>
<tr>
<td><strong>Fantasy Draft</strong></td>
<td>If checked, the game will start with a Fantasy Draft. For more on the Fantasy Draft, read Section 10.3.</td>
</tr>
<tr>
<td><strong>Players</strong></td>
<td>If checked the game will load as normal, but all player names will be scrambled, creating a new hockey world where existing talents are still present, but under new identities and with some of the talent pool scrambled as well.</td>
</tr>
<tr>
<td><strong>Attributes</strong></td>
<td>‘Fog of War’ refers to attribute masking. The concept in short is that even as a General Manager, your knowledge of the entire hockey world isn’t encyclopedic, and as such, there are players you will know little about. ‘Fog of War’ masks the attributes of players the game believes you will know little about, and as such, you must scout these players to reveal their abilities. If disabled, all staff will be visible from Day One.</td>
</tr>
</tbody>
</table>

Once you’ve decided upon everything, click ‘OK’, and the game will begin creating. This process can take a little time, longer on some PCs, and patience is therefore advised.

During this process, and at other times during the game where intensive game processing takes place, you will see a number of Hints and Tips. These offer short advice into various aspects of the game, from technical advice about the actual game to insight into certain ways hockey works.

**2.3. The Add Manager to Game Screen**

The following options are available in the Add Manager to Game screen:

<table>
<thead>
<tr>
<th>Area</th>
<th>Definition</th>
</tr>
</thead>
</table>

Page 8 of 62
Manager Name Your name, or the name of your manager(s).
Password Passwords are optional. They add to the security of a game, but please note, should you forget the chosen password, there is no retrieval system in place.
Experience Decide upon your level of playing experience. Eastside Hockey Manager™ recognizes many GMs and Coaches have played hockey to some level, and as such allow you to choose your own. Be aware that higher levels of experience will come with a greater reputation and as such greater pressure. Early on you may be given more leniency due to your reputation, but this could change over time, as with any manager of any experience.
Select Team Select your team from the list in the left panel. The right panel will display the team’s logo, and the basic information on the team. To change nation/league, select them from the panel area directly above the team list. Should you wish to view the roster before confirming, click on the team name. If you would like the game to randomly select you a team to control, click on the ‘Pick a Team for Me’ button.
Nationality Select your nationality. If you have a second nationality, or would like your GM to have one, select it from the option directly below.

2.4. Game Management Screen Common Elements

2.4.1. Titlebar and Menubar
The game menubar sits at the top of the game screen. The titlebar below it goes across the top center of the Game Management screen, and provides general information about what screen is currently selected.

2.4.2. The News Button
The news button is in the upper left hand corner of the screen and indicates the current number of unread messages. Clicking on this button will bring you to the current manager’s inbox.

2.4.3. Navigation Arrows and Quick Flicks
The navigation arrows can be found at the top of the screen. Their use is identical. They simply allow you to navigate back and forth between the pages you have visited.

Quick Flicks

Quick Flicks allow for simple and efficient moving between various pages. For example, if you are currently viewing the Positions screen on a Player Profile, using the back and forward Quick Flicks will scroll through all
players on the roster whilst maintaining the Positions screen, rather than defaulting back to the main Profile page. The dropdown button in the middle allows you to select all like items, for example all other players on the roster, or all other teams in a division/league.

2.4.4. The Continue Button

Clicking the Continue button will progress the game to the next day and beyond. Alternatively, pressing the Space Bar will do the same thing.

2.4.5. Quick Find

Clicking on the Quick Find icon opens up a search box. By entering text into the free text search box you are able to quickly find any team, player, staff, or nation in the hockey world. To clear the text, either click the red ‘x’ button which will appear when text is entered, as shown above, or use the backspace button on your keyboard.

2.4.6. Menus/ Drop-Downs

Clicking on any of the menu headers will drop down a menu with numerous options on. The specifics of these options are detailed throughout this manual.

2.4.7. Report and Action Buttons
Action buttons will usually offer a Yes or a No choice, as indicated in the screenshot.

2.4.8. Filters

Filters are most often found on Player and Staff searches and Scouting assignments. The above screenshot is an example of a typical filter configuration. Each field either has a dropdown with a choice of options or a free text field where you may physically enter the chosen parameters (Text, Age, etc). The Attributes section (shown above as an option) works in a similar fashion, with the user being able to search for players or staff with a chosen minimum attribute value. Clicking on the attribute name itself will default the value to 10, clicking the number will raise it in increments of 5. The +/- will change the value by one accordingly.
3.0 The Options Menu

3.1. Save Game

In the interest of keeping your saved games safe, it is advisable to save your game at regular intervals. It is also advised that you make and keep regular backups of your saved games in both a different directory and an external device in order to ensure the safety and longevity of your games.

3.2. Add General Manager

Please refer to Section 2.3, where this is run through in detail.

3.3. General Manager Status Screen

This screen displays the status of all human General Manager in your game. It also details the saved game information.

3.4. Detail Level

The Detail Level screen allows you to configure the level to which competitions are simulated in Eastside Hockey Manager™. Some users will be playing the game on a PC that may not be able to handle excessive processing, whilst others may just wish to exclude certain competitions from full simulation to further speed up their career.
The screen is divided by nation, league, and competition. The header of each allows you to set a ‘Preset Configuration’ for all competitions underneath it. Whichever you set it to, each competition will simulate accordingly. You then have the choice to set individual competition levels, with the options shown in the screenshot. All simulates every game in the competition. Later Stages will simulate playoff/late rounds of cup action, and None uses the quick game engine only.

3.5. Preferences

The options on this screen are detailed in depth in section 2.1.2.

3.6. Selected Leagues

This screen shows all Leagues loaded into your current saved game, and allows you to set them to Enhanced or Standard at any time (with the exception of the league you’re currently playing in).

3.7. Game Credits

These are the people responsible for developing Eastside Hockey Manager™.

3.8. Websites

This displays assorted websites, forums, and communities amongst Eastside Hockey Manager™ fans and contributors.

3.9. Exit Game
Exit Eastside Hockey Manager™ and return to your desktop.

4.0 Key Screens

The key screens for managing your team are documented throughout this section.

4.1 The Roster Screen

The Roster Screen is similar to the News Screen in that alongside it, it is probably the most important area of your hockey world. Here are your players, those who your fate ultimately lies with. The screen contains vast amounts of information and options, but first, familiarize yourself with it:

This is probably the busiest screen in Eastside Hockey Manager™ and there are tons of features and options in places you may not immediately think of looking, so we’ll spend some time in depth on this.

Your active roster is listed by position, displaying their biographical details. Selecting the ‘View’ button to the top right will give you the options below:
Selecting the **Contract** view will display contractual details for each player, including their salary for this season, the date their current deal expires, and any clauses. **Selection** shows recent form and player condition/morale, whilst **Attributes** shows sortable player attributes. **Other** shows some other biographical details, including whether the player currently has a team holding Rights to him for a given league.

The other options are far more detailed and important to your team and require further depth and explanation.

### 4.1.1. Roster Management

The Roster Management screen allows you to move your players between affiliated teams, should the team you’re managing allow for that to be possible.

![Roster Management Screen](image)

The parent team is on the far left, and all possible destinations for the players are displayed in columns to the right, to the maximum of three, as displayed. If a player is eligible to be assigned to a team, that team will be displayed in a solid **white** font. If they are not eligible to play for a team, that team will be displayed in a faded **grey** font. The team the player is currently playing for is displayed in **yellow**. To assign a player to a team, click once on that team name, and it will highlight in yellow, indicating that player has now moved teams.

Your affiliate teams may have limits on how many players they can have on a roster, or indeed, how many they can receive from an affiliate team, so be wary of this when assigning eligible players to their new locations.
4.1.2. Contract Management
This screen works under the same concept as the Roster Management screen. The layout is similar:

<table>
<thead>
<tr>
<th>Inf</th>
<th>Name</th>
<th>Position</th>
<th>Status</th>
<th>Salary</th>
<th>Rep.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Redoslov Gajdos</td>
<td>G</td>
<td>Core player</td>
<td>$925,000</td>
<td>V. Good</td>
</tr>
<tr>
<td></td>
<td>Jake Naud</td>
<td>G</td>
<td>Depth player</td>
<td>$1,300,000</td>
<td>Good</td>
</tr>
<tr>
<td></td>
<td>Dante Duchesine</td>
<td>LD</td>
<td>Core player</td>
<td>$3,900,000</td>
<td>V. Good</td>
</tr>
<tr>
<td></td>
<td>Darryl Idowu</td>
<td>LD</td>
<td>Depth player</td>
<td>$1,656,000</td>
<td>V. Good</td>
</tr>
</tbody>
</table>

The key column on this screen is the ‘Status’ column. Alongside each player you will find his current roster status (and his salary, as shown). By holding the mouse cursor over the status, you activate the stealth button for that player, and are now able to change the status via a dropdown of all possible options. Where previously you would be asked to confirm this (and still are should you choose to do this from the players’ Actions menu), there is no confirmation needed on this screen. Your choice, once made, will be in place, until you decide to change it again.

4.1.3. Reserve List
The Reserve List, where eligible, includes every player who is part of the organization, be that signed or unsigned. There are restrictions placed on the number of players you can have contracted/overall, which are displayed at the bottom of the screen (as shown, it is red because the limit has been exceeded).

To remove players from the contracted list, place them on Waivers. Waived players do not count towards the list and as such this is the easiest way to trim down the list in an emergency (if you must cut it down before a game, say). Releasing players will also naturally cut it down, but players will have to pass Waivers first. To cut down the overall larger number, including those you have not signed, you may release the rights to a player, and he will immediately be removed from the list.

4.1.4. Waiver Eligibility
This screen shows the players on your current active roster and whether they are eligible to pass between teams without having to pass through Waivers.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Redoslov Gajdos</td>
<td>G</td>
<td>28 yrs</td>
<td>85</td>
<td></td>
<td>V. Good</td>
</tr>
<tr>
<td></td>
<td>Jake Naud</td>
<td>G</td>
<td>28 yrs</td>
<td>32</td>
<td></td>
<td>Good</td>
</tr>
<tr>
<td></td>
<td>Dante Duchesine</td>
<td>LD</td>
<td>30 yrs</td>
<td>580</td>
<td></td>
<td>V. Good</td>
</tr>
<tr>
<td></td>
<td>Darryl Idowu</td>
<td>LD</td>
<td>26 yrs</td>
<td>242</td>
<td></td>
<td>V. Good</td>
</tr>
<tr>
<td></td>
<td>Isobell Notaror</td>
<td>LD</td>
<td>19 yrs</td>
<td>0</td>
<td></td>
<td>OK</td>
</tr>
</tbody>
</table>

The screen features the number of eligible games a player has played, and whether the player would consequently have to pass through Waivers – if the box is ticked, he will have to.

4.1.5. Shootout Choices
From this screen you select your choices, in order, for shootouts. To assign a player to a shooting spot, either click the area to the far left of his name, and the number will appear, or drag and drop the number from the list at the top of the page.

That’s just a dip in the water for this screen really. There’s a lot more, starting with the other dropdown menus at the top.

**Roster** contains the ability to ask your Head Coach/Assistant to dress his choice of players, or dress them and auto-assign them to their lines in the tactics screen. You may also clear all dressed players from this screen using the ‘Clear Roster’ option. Just make sure your team is employing one.

**Scope**, when it appears in context on some screens (such as Selection) will allow you to change between different types of statistics – for example, you may wish for the screen to display Playoff statistics rather than Regular Season. You can do that from here.

**Filter** allows you to narrow down the roster view to just players by a position, a side, or a contract type.

One of the simple and important things you need to do from the Roster screen is to dress players for each game. From any of the views, you can do this by clicking the (empty) area in the leftmost column. If you dress a Goaltender, this will show a G, and if a Skater, an S:

The screen will also display the maximum number of players allowed to be dressed for the competition in which you will play your next game, as well as the maximum roster size for that competition.

From the **Actions** menu, there are a host of other options.

These operate in the following ways:

**4.1.6. Set Jersey Numbers**

You are able to set the jersey numbers your players will wear at any time during the regular season or playoffs. The screen looks and works in a similar way to the shootout choices screen detailed previously.
To assign a number to a player, either drag and drop the number from the area at the top or bottom to the No. column, or click in the empty area in the No. column to assign that player the next free number. Some numbers will be unavailable for use, as the club has retired them. Once happy, submit and confirm your selections.

4.1.7. Set Team Needs
Clicking this will bring up a dialog box asking you to set your team needs. These are what other teams will look at should they wish to approach you with a trade.
Your Head Coach offers his insight into what he believes are the weaknesses in the team. You are not required to select all five needs – un-ticking the box shown will remove that need from view.

You can also set a general ‘Team Philosophy’ for other teams to attempt to adhere to when proposing trades. Your options are:

**Balanced Approach:** Not showing a great preference for particular assets.

**Focus on Winning Now:** Looking to add veteran contributors and any players who would be able to make an impact on a team challenging for honours.

**Favor Young Players:** Looking to add younger players and some prospects without necessarily looking to rebuild, perhaps if the depth chart is weak in these areas.

**Rebuild with Prospects:** Looking to start over with younger players and prospects who can play a little now and become contributors over time.

**Rebuild through Draft:** Look to add draft picks for expensive and under-performing players who can be moved to teams looking to win now.

### 4.1.8. View Team Report

Before getting into detail on the Team Report, please note **you must have an Assistant GM employed for this to be enabled.** The Asst. GM provides the report, and as such, one must be employed.

The team report consists of a ranked Depth Chart and lists of team ‘bests’ and prospects.
These rankings are not customizable, they are, as stated, the opinions of your Assistant GM. The content is also subject to change, naturally, as players will improve or decline over time. You are able to filter down by position from the options across the top of the screen.

The ‘Performance’ option does something a little different. It shows you which of your players are currently on hot streaks, and which are on cold. It does the same for your current prospects.

### 4.1.9. Compare Teams

To compare your team with another, select this option. The game will present you with teams you’ve recently viewed (clicked on) as options to compare with. Once you’ve found your chosen team on the list, select them, and the game will begin comparing the two.
This is the General view, as the teams are ranked in standard hockey areas on a scale of 1 to 5, 5 being the maximum. Comparisons are also made between Team and Player statistics, and you can view a table of all games between the two teams since the start of the save, with the most recent games listed below it (and any forthcoming games between them in the current season). These are filterable both by time and by venue, so you can see if one holds a particular dominance in some form.

4.1.10. Print

You have the option to print various items from your roster. For more information on setting up printing preferences, please refer to the table in 2.1.2.

4.2. Board Confidence

The Board Confidence screen is something you’ll not need to look at if you’re doing well but will find yourself increasingly visiting should your team start to struggle. The team owner(s) will give you feedback on the job you’re currently doing and how you’re dealing with various aspects of running the team. Each month, they will send a news item to your inbox updating you on their thoughts, and whenever you visit this screen they’ll also inform you of your progress.

4.3. Resign From Team

Alternatively, you could simply pack it in at your current team and resign from your post. Selecting the option from the Manager Menu will bring up a dialog box:
Should you wish to resign, select Yes. If you have a change of heart, or have accidentally selected this option, then select No.

4.4. Front Office

The hub of your managerial career and main reference point for the important day-to-day news and functions you’ll need in Eastside Hockey Manager™.

The main panel features six different smaller panels that are customizable. You can have them display any choice from the dropdown list below, by clicking the arrow pointer in the header.
4.5. News

The News Screen is perhaps your single most important in-game area. It’s here where you will receive all the most important information about you, your team, and the hockey world. To access the news screen, simply select the option from the General Manager drop down menu or click the Mail icon, which is ever present in the menu bar at the top of your game screen.

The screen is divided into two main areas:

The upper panel displays your entire inbox, with items sorted chronologically from the top down. The item will carry a title and a date, much like any typical news story. Clicking on any item will display the news in more detail in the lower panel. This part of the screen works just like your typical email browser. Eastside Hockey Manager™ will report to you all the important aspects of the particular news item. To view any player, staff, team or league discussed in the news item, simply mouse over the name. The mouse icon will change to indicating you can click this area. Doing so will take you to the appropriate screen.
The Categories option allows you to keep your inbox organized and relevant. You are able to filter out any unnecessary news items and find the particular ones you want to read or refer to quickly and efficiently. The News Screen ‘Search’ function allows you to enter key words or phrases to find a given news item. To clear filters, select ‘All’ from the Categories menu.

4.6. Scouting

For more information on Scouting, please refer to the Scouting section!

4.7. General Manager Stats

This section features an array of statistics on all General Managers in the world of hockey so you can see who’s doing the best job, who’s been in their post the longest and all manner of other interesting facts and figures.

4.8. Job Information

Should your fortunes at your current team be fading, or should you simply wish to move up the ranks of management to a higher level, the Job Information screen should be your main port of call. Any jobs that are currently vacant in the hockey world will be listed on this screen. Should you wish to apply to any of these, select team and then the option to apply from the bottom of the screen. Be aware though, applying for a job whilst still under the employment of another team could easily anger the owners, players and fans. Consider the consequences of any action before it is taken.

4.9. Transactions

A list of all transactions in hockey, from trades to transfers to waiver moves and free agency deals.

4.10. History

The History Screen details all of your key moments as a General Manager from the moment you’re hired to the day you retire. Trades, Wins, Losses, Awards – they’re all listed here. The ‘View’ and ‘Filter’ options allow you to see only certain achievements/incidents.

4.11. General Manager Options

This section allows you to delegate certain tasks to your Assistant GM, either during your day-to-day activities in charge or in the event you decided to Go on Holiday.

Coaching Options

Coach Games Yourself: If set to no, each game will be handled by your Assistant GM and simply generate whilst processing rather than going into the game itself.

Head Coach arranges/takes control of Exhibition Games: If you don’t wish to arrange and partake in your Exhibition game schedule, set these to No.

Head Coach takes control of practice: If you want to delegate daily practices to your Assistant, set this to No.
*Use current tactics/team selection/lines*: These options determine how much flexibility you afford your assistant when delegating game-coaching duties to him. If set to Yes your instructions will be carried out as closely as possible; if No, your Assistant will coach things to their own style and preferences.

**Vacation Options**

You also have a host of options to set for how contract renewals, player statuses, trade/transfer offers and job applications are handled should you be away on vacation; the length of which is configured at the very bottom of the pop-up dialog.

**4.12. Boxscores to Show**

This section allows you to configure the results that are delivered to you from leagues outside of the one in which you are managing. For example, if you want to receive results from Canadian Junior leagues whilst playing in the National League, you can do so using this section.

**4.13. Go on Vacation**

For whatever reason, you may wish to hand over the reins at your team to your Assistant and spend time on vacation. The game will process uninterrupted (unless you intervene) for the duration of your absence and allow you to return on either the designated date or upon your intervention by clicking on-screen.

You have a number of configurable options available to make your absence smoother; these are discussed in section 4.11.

**4.14. Scouting and Player and Staff Search Screen**

There will be times when you feel the need to go out and strengthen your organization. You can do this, and more, from the Player and Staff Search screen(s).

The list is currently sorted by Player Reputation – the Star rating signifies the players with the biggest reputation and abilities in the hockey world. Of course, 300+ pages is a bit steep to hunt through, which is where the Filters menu comes into play. From it, select ‘Configure’, and then refer to the instructions on Filters in section 2.4.9. From this menu, you’re also able to filter out everyone except Unrestricted Free Agents. For more on Free Agency, please refer to the section later in this guide.

This screen is highly configurable and is worth spending some time playing around in to familiarize yourself with the wealth of options in order for you to use them to full effect. The ‘View’ menu allows you to view each player by attributes, contract details, season statistics – you name it, it’s probably there. The ‘Search’ menu allows you to save
down searches through the ‘Export’ function and use them in other saved games (using the ‘Import’ function), saving valuable time. The ‘Scouts’ menu displays your current scouts and their assignments. Clicking one will display his findings under the ‘Scouting’ option on the left menu bar. For more on scouting, please read Section 8.0.

The Staff Search screen works in near identical fashion. Non-playing staff are listed in the same format and are filterable under the same options, except you can naturally filter to non-playing attributes rather than playing ones.

The Shortlist screen (also an option from the left menu bar) once again works in a very similar way, but there are a few different options here. Over time, your shortlist is likely to become anything but short, so you may like to clear some players from it. To do so, select ‘Delete’ from the options at the top, and then select the player. You will be asked to confirm your decision. You can also remove a player from your shortlist in his Actions menu. You can clear the entire shortlist in one swift movement by selecting ‘Search’ and then ‘Clear’.

As with the various player searches, you can save multiple shortlists, and load them into the search whenever you wish, using the same options. This can be particularly useful when preparing for drafts and free agency, amongst other things. Please note that saved shortlists are only valid for the saved game in which they are created.

4.15. The Change General Manager Menu

As each game supports a maximum of 30 General Managers, there will usually be the need to change between users. To do so, select this option and from the dialog box that appears, simply select the name of the General Manager you wish to control.

5.0 The League Menu

5.1. The League Screen

The League screen is of particular importance. From the League Menu Header (e.g. National League) on the title bar, select ‘standings’
The sub-menu options are explained in depth below:

**Standings**
Displays the various standings for the league in which you are managing. By default, this screen will show the division/conference your team is in. All other views are accessible from the ‘Stage’ dropdown.

**Schedule**
The entire season schedule. The screen defaults to the games scheduled for that day, or the next scheduled games should there be none. Use the calendar to change to a chosen date.

**Overview**
An overview of the league season, which indicates various important dates, such as Trade Deadlines and Playoff dates.

**Team Stats**
In-Depth ranked team statistics from the current season.

**Player Stats**
Player statistics and league leaders in numerous areas and contexts.

**Referees**
Refereeing statistics.

**Trade Center**
Displays all trades made in the current season.

**Injury List**
Lists all known injuries around the league.

**Information**
The standard information about a league – teams, rules, scheduling etc.

**Hall of Fame**
Top retired players who’ve enjoyed success in this league.

**Awards**
Current and historical league award winners.

**History**
Historical leaders and statistics from the league since inception.

Some of these can be seen in greater depth below:

### 5.2. Scores & Schedules

This screen displays all games scheduled for a particular day.
Each boxscore will display the overall records of the respective teams and their home/road record.

To view scheduled games from a different date, select the date from the calendar view towards the top of the panel.

### 5.3. Player and Team Statistics

This section covers all the statistics you’ll need to keep abreast of everything going on in your league.

The screen defaults to the leading Points scorers in the league, but any single ranking can be sorted. Stats are given in numerous categories, each displaying the league leaders.
The Team Statistics screen operates slightly differently. By default, the screen displays each team’s record over the last ten games.
From the ‘View’ menu, you can also select a wealth of statistics, grouped under four categories – General, Offensive, Defensive, and Special Teams. So, for example, if you wanted to see how many Penalty Shots your team had been awarded (and scored), you’d select ‘View -> Offensive -> Penalty Shots’.

For more detail on statistics and their meaning please refer to Section 14.0.

5.4. Transactions and Trade Center

The Transactions screen is the place to find all player movements in your hockey world. By default, the screen will show all transactions on a monthly basis (sorted and updated daily). From the ‘Filter’ menu, you have the option to view movement only involving players, or staff, or even only trades or waivers. You can also filter out transactions to a certain league or nation.
The Trade Center screen is a little different, and is located on the left menu bar for any league that operates under trading. The screen will show all trades that have taken place, and the particulars of each deal. By default, the screen shows all trades from the current month, but you are free to change the month using the back and forward arrow indicators. From the ‘Trade’ menu, selecting a team will take you to the Trading screen, and allow you to propose a trade to that team. For more on trading, please read Section 11.0.

5.5. The History Screen

This screen holds the detailed history of a competition; from tracking each and every winner every season through to individual accolades in goals, assists, penalties and more. The historical statistical world is in fact your oyster here.
6.0 Tactics

The following section details the new tactics screen and the wealth of options available here. Make sure you take everything in, tactics will be vital to your success and a massive reason for your losses.

6.1 The Tactics Screen

From here you are able to comprehensively set your entire tactical instructions. We’ll also go into some detail here, outlining the numerous facets of hockey tactics and how each one might affect your team.

Firstly, we’ll run through how to set your lines, so you have players assigned to positions and can assign personal tactics.

The ‘Set Lines’ screen looks like this:

To assign a player to a position, select him by clicking his number (the button graphic will show as depressed and text will be highlighted yellow), and then left click on the position and line you wish to assign him to. Right clicking will remove a player from that position. Selecting ‘Ask Coach’ will have your assistant complete your lines for you.

The main overview page is the area where the general setup takes place, but underneath there’s a lot more.
The General Team Options section is where you’ll set the basic instructions. Top of the list is your captain and his alternates. Attribute-wise, you should look to players with high influence and leadership skills, but also a player who leads by example on and off the ice. He’ll be the leader of the team and the player others (in particular rookies and young players) turn to when situations become tough. This all applies to the choices for Alternate captains, but also consider future candidates for captain – allowing them the responsibility of wearing the ‘A’ could give them the confidence to grow into the type of player ready to wear the ‘C’.

You can also choose the two players you’d most like to throw on as the extra attackers in situations where your goaltender is pulled. The first choice will always be looked to first, but in situations where it may not be possible (if he’s on the ice at the time or in the penalty box/injured the other choice will be used.

Forward/Defense/Powerplay Usage determines how long each player spends on the ice. The default ‘Normal’ will use all pairings/lines but stagger the minutes so the higher ones receive more icetime. You can choose to roll all pairings and lines equally, just the top three lines/two pairings, or overload the top line and pairing and give them excessive time on the ice. The players you have on your roster will determine how you generally will go about doing this. If you have a solid base of players who are all quite similar, rolling all lines equally might be the most effective measure, as you’ll have a consistent threat on the ice often, and players will be fresher. If your team has one or two star players, a lot of good players, and a fair number of rookies and inexperienced players, it would make a lot more sense to give a good portion of icetime to the star players. Rookies have to play, yes, but exposing them to big minutes and tough situations early in their career, especially in situations they may suffer in, can harm their confidence and development.

Line Matching offers you the ability to match one of your chosen lines against one of the opposition. You may wish to shut down an opponent’s star player/line with your best defensive players, or you might equally wish to avoid your best players being shut down, at which point you would ensure that you send them out against the weakest line.
the opponent has. In all possible combinations, your team is listed first, so in ‘1 vs 4’, you would be sending your first line out against the opponent’s fourth line.

Finally in this panel, **Shot Targeting** determines where you want your players to aim a majority of their shots. If you notice the opposing goaltender has a particular weakness, say, with his ability to save low shots, you can tell your players to attempt to expose this weakness as often as they can in order to maximize chances of success. Similarly, if your collective group of players appear to have a knack for finding a given area of the net (analyzing shot charts can be a useful tool to find out this information) it might be worth encouraging them to do it more.

### Advanced Options

From here you can prevent your instructions from being carried out as standard across your entire team. Checking ‘Use Unit Tactics’ will allow each individual unit to play under different instructions. Leaving it unchecked will utilize your general Even Strength tactics for all Even Strength units, the general Power Play tactics for all Power Play units etc. When un-ticked, you can change the current general tactics to view and/or edit from the dropdown menu in the subtitle bar.

You can also set your team’s defensive coverage style. ‘Zonal’ will see your players attempt to take up zones and force the opponent to make plays in and around them. ‘Man’ will assign player to player – winger to defenseman (and vice-versa) and center to center. This is a technically sounder tactic as each player is responsible for covering an opponent but leaves the risk of being burned if a player is beaten one on one.

The **Tactical Settings** section features a number of sliders, which command your players to do certain things. Each slider has a five-click scale ranging from low to high frequency. The options are explained below:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Slider Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentality</td>
<td>Very Defensive – Very Offensive</td>
<td>The general style in which your team will play the game. A very defensive mentality will see the players do all they can not to concede goals but they will be cautious offensively, whereas very offensive will see them go all out to score as many goals as possible, but would be prone to leaving holes in their own end.</td>
</tr>
<tr>
<td>Aggressiveness</td>
<td>Calm – Berserk</td>
<td>This sets how physical your team will play in general. A general calmness will see the team play technically better hockey, but they won’t assert themselves so much. Going all out berserk will solve this, but they run the risk of going over the top and becoming badly exposed.</td>
</tr>
<tr>
<td>Backchecking</td>
<td>Very Easy – Very Hard</td>
<td>Very Easy backchecking will give the opposition an easier time when attacking as they won’t be faced with so many bodies – your players will remain up the ice awaiting a clearance they can jump on. Very Hard will require a lot of effort from your players, as they’ll be tracking back every time they lose the puck, desperate to get it back.</td>
</tr>
<tr>
<td>Feature</td>
<td>Range</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gap Control</td>
<td>Very Tight – Very Relaxed</td>
<td>This slider controls how much of a gap your players leave between themselves and the opponent with the puck. Very Tight will allow the player to get right into his face and not give him any room to breathe, whilst Very Relaxed will eventually force the opponent into a play as the defense collapses on their own net.</td>
</tr>
<tr>
<td>Puck Pressure</td>
<td>Very Easy – Very Heavy</td>
<td>Similar to the Gap Control slider, this determines how much and how often your players pressure the puck. Very Easy will see them stand off and wait for their chance, and Very Heavy tells them to chase the puck all over the ice to get it back as quickly as possible.</td>
</tr>
<tr>
<td>Hitting</td>
<td>Very Easy – Very Hard</td>
<td>This ties into the Aggressiveness slider a little, in that the ideas behind both are similar. A team which hits hard and often will make their influence felt, but would be prone to taking more penalties and giving up important scoring situations. A team who rarely hit and when they do rarely finish their checks will be seen as a weak team and opponents will have the freedom to make more plays.</td>
</tr>
<tr>
<td>Tempo</td>
<td>Very Low – Very High</td>
<td>A team who play an urgent (Very High) tempo usually chase games and make things happen a lot, but as with a lot of sliders where teams over-commit, they run the risk of exposure. A very low tempo demands the team build up patiently and stress a puck-possession game.</td>
</tr>
<tr>
<td>Passing</td>
<td>Very Safe – Adventurous</td>
<td>Very Safe passing will link to a slower tempo, as teams attempt to keep the puck, knowing they can’t concede whilst they have it, and look to build offense slowly and patiently. More adventurous passing can be successful and a game changer, but the players using it must be good enough to regularly pull off such passes.</td>
</tr>
<tr>
<td>Shooting</td>
<td>Very Selective – Barrage</td>
<td>Telling your players to shoot on sight (Barrage) is a useful tool for working on a team’s goalscoring deficiency. You’ve got to shoot to score, so why not shoot often? Some would say selective shooting is a better philosophy, taking shots when they’re on and offer the best chance of scoring instead of turning the puck over.</td>
</tr>
<tr>
<td>Dumping the Puck</td>
<td>Very Rarely – Very Often</td>
<td>This would tie into your team’s style of play. If you have the players to play a dump and chase style game, then dumping the puck often will work better, as well as keeping your players fresh (more dumping gives more chances for line changes). Not dumping the puck will see players retain the puck and look to build offense all the way to the net.</td>
</tr>
</tbody>
</table>
The descriptions above deal with the two extremes – everything in between works slightly like one or the other depending on which end of the scale the slider is set to, or a balance of both if it’s set to the middle notch.

The **Tactical Positioning** display shows where your players will line up on the ice based on puck position and the tactic you’re using. Right clicking in a chosen square will select it, and the players will move accordingly, showing where they’ll try to be. You can view these positions both offensively and defensively, and by clicking ‘Show Movement’ you can see where the tactic tells them to go from that position depending on the situation.

The above all applies to the ‘Unit Tactics’ tab, which allows you to set different assignments and tactics to specific lines – be it even strength or special teams. To enable the usage of this, you must tick ‘Use Unit Tactics’ in the main Tactics overview.

**Tactical Systems**

You have the option of now telling your players to play a certain way in certain situations tactically rather than personally. These areas deal with the ‘nitty-gritty’ of hockey – this is where the game can be won or lost. The tactics and options are broken down below:

**Breakouts** determine where your players will line up on the ice for breakout plays when the puck is in possession in their own end, and where they’ll attempt to move. By following the guidelines in the Tactical Positioning section above you’ll be able to see where each of your players will go and move to based on your selection. The options are fairly self-explanatory – your players will either move out in a standard breakout formation, maybe narrow or wide, or your wingers may cross over, attempting to take an opponent with them and create space. Depending on the style of the opposition, you may wish to change this from game to game. If the opponent has a notably slow defensive unit, having your wingers cross over can expose their lack of wheels and create big opportunities. Similarly, if you have players who are consistently good at something, and it works, don’t change it.

**Neutral Zone Offensive** is quite similar. Here you instruct your players on how to enter the offensive zone. Again, you have the option to have your wingers cross over a lot (or just switch), or you can tell your players to group together closely. As you get closer to the blueline the opposition’s defense will likely collapse deep, leaving you more space at the top end to move around and set up. If they don’t collapse and you notice them challenging you, you could react to it by using the crossover command, thus dragging opponents with you, potentially out of position.

Once the players have crossed into the **Offensive Zone** they should be making their final moves to get into optimum scoring position. Positional will ensure they stay in the area of ice expected of someone in their position and will look to score from there. You can attempt to overload the slot and put pressure on the goaltender, a tactic which works particularly well against teams with small and not particularly physical defensemen. Asking them to line up in a triangle style will see the Center pivot ahead of the two narrow wingers, who look to pick up on loose pucks and rebounds.

The next three options deal with the defensive aspects of the game. First up you have **Forecheck** options. You can keep it simple by asking your players to maintain position and check either high up the ice (in the offensive zone) or low (as opponents make their way over their own blueline), or you can be a bit more adventurous and attempt to implement one of the different formation styles. The 1-4 formation used in forechecking is the first stage of a neutral zone trap style of play. One player, typically the center, will advance and press the puck, whilst the other two forwards will drop in and form a long ‘wall’ with the defensemen in a very conservative style of hockey used by teams with lower levels of talent. The 3-2 formation is more conservative, your players will line up with three across the back end (one of the forwards drop in) and two holding position, with the aim to keep the opposition forwards in check. The final option, the 1-2-2 formation, is probably the simplest of all to implement, as your players will attempt to force the opposition to build plays from their own end. The center operates as the ‘1’, with both wingers falling back deeper.
The same theory applies when the play comes further down the ice, and you need to set your **Neutral Zone** **Defensive** formations. In each, one or more of your forwards will move into a deeper position to make it hard for the opponent to find space to break into. Your **Defensive Zone** formations are more ‘limited’ in that you can either allow for your players to maintain a natural position, stay open and attempt to force the opponent to beat them one on one, or collapse in and protect the net as much as possible. Again, the option you choose really depends on the players you have at your disposal, and the strength of the opponent. If you have big and physical players and a goaltender that excels in traffic, collapsing on your net can be a great way to protect and not concede goals, but if you try implementing it with the wrong players, it can have disastrous consequences.

The final two options deal with your offensive and defensive **Faceoffs**. Offensively, you can choose to stick to a standard formation, or to attempt to overload the slot off the draw. More aggressively, you can choose to attempt to have someone attempt a drop pass off the draw for a shot, or perhaps to attempt to line up a shot from the point, a tactic particularly useful on the powerplay. Defensively, you can implement the first two options above, with the final option being to line up lop-sided, bringing more men to the inside of the faceoff and thus more men around your own net to clear the slot and block shots should you lose the draw.

Remember, the above are all positional-based commands, instructing your players where to go on the ice. The sliders outlined above will determine how aggressively they play, and how they go about playing their actual game. However, player positioning is a massive part of winning consistently, as if you can get a fluent formation going in all three zones you can make it hard for the opponent to break you down, and the fewer chances you give up on net, the lower the chances of conceding become.

**Personal Tactics** work once again in a similar way. Select the player as you would to assign him to a line (detailed above), and his personal instructions appear in the right side panel. At the top, you can choose whether you want the instructions to be used all the time or to be just situational. The tactical settings are the same as detailed above but on an individual scale, and then the ‘Additional Options’ allows you to set commands specific to the player. You can tell him to shoot or pass more often, to fight or not, to carry the puck or pass it up, to join rushes or sit back on the play, and to check/follow a particular player all game (the list displays all players on the team of your next opponent). The instructions you set will generally be determined by the kind of player he is. An offensive scoring type will, as a rule, not be allowed to fight, and will be told to shoot and carry the puck on rushes. A checking, energy player, perhaps a fourth line center, will possibly be allowed to fight and maybe follow around an opposition player as he attempts to make an impact for his team.

Once you’ve been through the process of creating a tactic, you’ll probably want to save it for use in other saved games, or simply to safeguard your work and have a base to refer to if further tweaks aren’t to your liking. To do so, select ‘Save Tactic As’ from the ‘Tactics’ dropdown. Tactics are saved to My Documents\Sports Interactive\Eastside Hockey Manager™\tactics. To load a tactic, select ‘Load Tactic’ from the ‘Tactics’ menu. To delete a tactic, select ‘Delete Tactic’ from the same menu, or physically delete them from the directory named above. These rules also apply for the saving and loading of Unit tactics.

### 7.0 Personnel

Your backroom staff are really important. If you can put together a strong unit of Assistants, Coaches, Scouts, and Trainers, you’ll be set off the ice for some time. These guys work with your players day in, day out, and will be in the most regular contact with them. You should take time to get the right people hired.

The following are backroom staff types you can hire, and what they do.

**Head Coach:** The most important non-playing staff selection you’ll make. He’s in charge of the team on game days. He leads practice. He’s one of the most recognizable faces of the organization. You’ll want a guy with high (15+ at the top level) attributes in all areas, especially those you wish to implement fully into your team (for example, a Junior team Head Coach should have very high numbers for Working With Youngsters).
You have the choice at any time to sack your Head Coach and bring in a new guy, should your fortunes be taking a
turn for the worse. Be aware though, if you make your way through coaches like they’re going out of fashion, your
Board of Directors will soon take notice and it could be you on your way out of the door if it persists without results.

Assistant General Manager: He’s your right hand man, the guy who will step in for you if you’re unavailable and
the man you can delegate assorted tasks to should you wish to go on vacation. One of the more useful things your
Assistant GM provides is the ability to view a Team Report (from the Actions area on the Roster Screen). He will
evaluate all players in your organization, signed and unsigned, and rank them by position. This acts as an unofficial
depth chart – whilst it’s not fully interactive in that you cannot change the order, it will change throughout the
season as players improve and decline and is a useful tool for considering line combinations and depth. Your
Assistant will also name the best and worst players in certain areas and also name your top prospects.

When hiring an Assistant GM you’re looking for a man strong in most attributes. He should ideally follow your
ideals – if his preferred tactics and coaching style match yours it’s a bonus. Strong Discipline, Man Management,
and Determination are all required. Anything else above a 15 (at top level) is desirable; he’s one of the most
important people in the organization and should be very competent at all facets of the game.

Assistant Coaches: Your coaches will interact with your playing roster more than anyone else. You should aim for
at least six quality coaches, maybe two to three more if your budget allows it and your roster demands it.

In order to make quality additions to your coaching staff it’s important to understand the attributes each non-playing
staff has.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adaptable</td>
<td>Staff joining a new team will integrate better and quicker. Foreign staff will be able to settle in easier.</td>
<td>How well he can settle in a new role/team/country and how quickly he can work to full capacity.</td>
</tr>
<tr>
<td>Determination</td>
<td>All staff, a determined backroom makes for a determined roster.</td>
<td>How big their desire is to succeed, how far they’re prepared to go for the team.</td>
</tr>
<tr>
<td>Level of Discipline</td>
<td>Generally all staff, but especially staff working on a team who may have troublesome players.</td>
<td>How disciplined and in control they are. A higher attribute suggests they complete their work under strict rules and regulations. The lower the number, the more relaxed he is, and as such he has less control.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Qualification</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Man Management</strong></td>
<td>Most staff, especially those with high responsibility and those who may deal with troublesome players.</td>
<td>How well he can deal with different members of the playing roster and how well he adapts to different situations regarding each of them.</td>
</tr>
<tr>
<td><strong>Motivating</strong></td>
<td>Head Coaches, one or two Assistant Coaches should also have high motivation.</td>
<td>How good they are at motivating their players. Each player is different so staff must be adept at finding ways to motivate their players and bring the best out of them.</td>
</tr>
<tr>
<td><strong>Working With Youngsters</strong></td>
<td>Staff working on Junior teams.</td>
<td>How good he is at working with young hockey players. Players who are still developing as players and as people.</td>
</tr>
<tr>
<td><strong>Coaching Goalies</strong></td>
<td>Coaches assigned to work with goaltenders.</td>
<td>How talented he is at coaching goaltenders.</td>
</tr>
<tr>
<td><strong>Coaching Defensemen</strong></td>
<td>Coaches assigned to work with defensemen.</td>
<td>How talented he is at coaching defensemen.</td>
</tr>
<tr>
<td><strong>Coaching Forwards</strong></td>
<td>Coaches assigned to work with forwards.</td>
<td>How talented he is at coaching forwards.</td>
</tr>
<tr>
<td><strong>Judging Player Ability</strong></td>
<td>Scouts working on teams you’re likely to face now or players you’re considering now.</td>
<td>How well he can identify a player’s current standing and ability.</td>
</tr>
<tr>
<td><strong>Judging Player Potential</strong></td>
<td>Scouts working on drafts and younger prospects.</td>
<td>How well he can identify a talent ceiling in a player and how well he can project the player’s future role.</td>
</tr>
<tr>
<td><strong>Tactical Knowledge</strong></td>
<td>Head coaches and a majority of coaching staff.</td>
<td>How knowledgeable he is of various tactical systems and his ability to work on counters to them, and developing his own systems.</td>
</tr>
</tbody>
</table>

**Scouts:** Scouting is discussed in far greater detail in Sections 8.0 and 10.0, but when looking for a scout you should primarily look for people with high ratings in Judging Ability and Potential. These are two areas you should consider as ‘must-haves’. Scouts strong in Tactical Knowledge, Working With Youngster, and any coaching attributes are very attractive to potential suitors as it’s likely they’ll have a stronger and more thorough understanding of hockey and as such will be giving more informed reports.

**Physios:** You’re looking for people with high Physiotherapy ratings (these are the only staff who have this attribute). Ideally you should have three or four physios to adequately deal with the number of players on your roster.

### 7.1. Practice

Your players need to practice. You can delegate the task to your Head Coach (from the General Manager Options menu), but if you wish to handle it yourself, this is the section for you.
As the screenshot shows, you can change the schedule a player is currently working under by selecting the stealth button next to his name and then changing to any of the options on the dropdown menu.

The lower left area of the screen allows you to set which coaches work with which schedules. Ticking the box will ensure a coach works on that particular area. Ideally a coach won’t have to work on any more than a maximum of three areas, two is more manageable and one is good, especially for goaltending. Assign coaches to their schedules based on their strongest attributes – a coach with strong numbers for Coaching Goaltending should work exclusively with goaltenders. If he’s very strong in other areas consider allowing him to work under other schemes but your goaltenders will benefit greatly from focused practice. The same rules apply across the board.

In the lower right you can set a time/percentage balance for the three general areas of the game to be addressed in practice. You have 100% to work with and can choose to balance them any way you wish. If there are any available numbers, the ‘Available’ section at the bottom will display this. The increment/decrement levels are in portions of 5%.

### 8.0 Scouting

Scouting is imperative to long-term success in Eastside Hockey Manager™. Your current team won’t be around forever and you’ll need to bring replacements in at a consistent level of both talent and number. You can access the Scouting screen from either the Front Office screen or your manager menu.
Select the scout from the ‘Scouts’ dropdown at the top of the screen, and then assign him as shown in the screenshot. Select ‘Assign Scout’, and then assign him to a nation/region/other as you wish. The options you have are detailed further here:

- **An individual team.** If you’re heading for a massive playoff showdown and want a complete report on the opposition, send one or two scouts to watch the team in question. They’ll report back with detailed facts and figures of each individual from that team.

- **An entire league.** Perhaps you’re managing in Great Britain. Knowing the caliber of players you’re likely to attract, it could be wise to scout a league which you know is of similar quality in terms of player talent, and as such a more realistic and viable opportunity to acquire new faces.

- **Next Opposition.** With games coming thick and fast in a majority of leagues you’ll want to have the low-down on whoever the next game is against. Having a scout watch your next opponent will provide you with a short but detailed report in the form of a news item prior to each game.

- **Shortlist.** You may have a list of players you’re interested in acquiring but would rather find out even more about them first. Having a scout watch all players on a particular shortlist is extremely useful as it cuts out the potential for a scout to report back on a player who doesn’t fit into your system, whilst still giving you thorough feedback on those you’re more interested in.

- **Youth Players.** It’s always wise to look towards the future, and even more so for teams on a tight budget. Sending a scout to look for young talent will usually result in a recommendation of a group of decent young players looking to ply their trade anywhere. Who knows, you could unearth a gem.

- **Draft.** If you’re managing in a league that has an annual draft at the end of the season, you can tell a scout to watch areas with players eligible for selection. Since this is usually a key area for most GMs, it could be worth allocating two or three scouts (personnel and finances permitting) to the draft in order for you to gauge a complete picture going into the draft.

- **Nation.** Some countries are a hotbed of hockey talent, so sending a scout to Canada, Sweden, or Russia will naturally return a vast number of players, of which you can guarantee at least a few will interest you. However, scouting some countries who don’t immediately spring to mind as massive hockey markets yet still produce top players (Germany, Austria, Switzerland and the like) could give you the player you’re looking for. It’s also a useful tool if you’re managing in a league with a foreign player restriction/limit. For potentially maximum effect, try assigning a scout who is local to that country. He’ll likely have better knowledge of hockey in his homeland and will be able to give you better feedback than perhaps a scout who is almost totally alien to that country.

- **Region.** If you want to be more general than specific and get a huge list of players you can then narrow down, scouting a region will help you. As with nations, some areas have far more players available to you, so choosing wisely could be the make or break for you.

Once you’ve selected where you wish the Scout to go, you’ll be prompted to give your scout instructions. The main option is Duration. You can have a scout visit an area temporarily, or station him there permanently. The latter is perhaps an option for scouts native to an area who are particularly efficient at finding the best players from that region. You can then specify intensity. An intensive scouting program will result in the scout giving detailed reports
on a large number of players, whereas a light schedule acts as more of a top-up, ideal for last minute draft preparation. You can toggle the other options on this menu to configure exactly how you want your scout to give feedback – from the age of the player to his reputation. You may already know the top players from a given nation, so choosing to ‘Ignore Well Known’ will allow you to get scouting reports on perhaps more obscure players, and indeed, players who are relevant to your team. It’s pointless if your scout reports back on players you have no chance of getting, so tell your staff exactly how you want them to work for you.

Once finalised, the scout will head off to his post and begin his role. Over time, the list on the scouting screen will be populated with players the scout has watched. His/her recommendation based on talent and how the player fits into your organization is shown by a star rating from zero to five, shown in the leftmost column. This star rating is also visible on the draft screen, by selecting a given scout in a scouting slot, then viewing the Scouting dropdown.

From time to time a scout will come across a player he personally recommends. This will happen in the form of a news item. It’s then up to you to decide the course of action to take, be that making an instant offer, scouting them on a personal basis, or simply ignoring it.

The feedback on individual players can be found on the Scout Report tab on each player’s profile. Here, scouts offer reports on recent games as well as player projections. Scouts will tell you what sort of production they can see from a player, where he fits into your organization, what sort of role he could play for you, and they’ll compare them to an established player in your league. A report card is also given, grading the areas of the individual’s game, much like a school report (grades from A+ to F).

With so many options available, you have no excuse for making a blunder when acquiring new players.

9.0 The Player Attribute Model

It is quite important to understand the importance of player attributes in Eastside Hockey Manager™ and how they affect various parts of the game, most particularly the game engine. Attributes are divided into three areas; Physical, Mental, and Technical. The attributes, how they react in certain situations, with each other, and alone, are detailed below, but it’s important first of all to outline how attributes work.
Each player is rated on a scale of 1-20, 1 being absolutely terrible, and 20 being elite. Some attributes are defined as ‘Absolute’, and some as ‘Relative’. Absolute attributes are those that are locked to an individual and can’t be trained so much, such as Determination and Work Rate. These are generally innate attributes specific to individuals. Relative attributes are those that can be compared to other players in the hockey world, and can be improved on through practice and player development. Physical and Technical skill sets are the main areas you’ll find relative attributes.

Using the “Alternative Attribute Ranges” option in the Preferences screen will display attributes differently. The player ratings will be displayed in a greater range, 1-100, which you may have gotten used to in other titles. Note that this option only changes how the attribute values are displayed on the screen and it will not affect the actual attribute values read in from the game database.

9.1. Physical

The Physical attributes section of a player’s profile looks like this:

```
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceleration</td>
<td>Scoring wingers in particular, but in general most players who require strong recovery and breakout speed.</td>
<td>How quickly a player can reach his top speed from a standing start. The attribute will correlate with Speed – you’ll rarely find a player with a massive difference (&gt; 5) between the two.</td>
</tr>
<tr>
<td>Agility</td>
<td>Speedy wingers you’ll expect to impact upon your play, and players with top speed.</td>
<td>How adept a player is at keeping his balance and moving quickly in tricky situations.</td>
</tr>
<tr>
<td>Balance</td>
<td>Everyone. Players need to be able to skate to be at all competent on the ice, and balance is fairly key to that.</td>
<td>How well he stays upright and on his feet in physical contact and quick turns on skates.</td>
</tr>
</tbody>
</table>
```
Players with impact speed will always be better against slower players. Speed kills and is a very useful tool in hockey.

The player's maximum skating speed, regardless of how long it takes him to reach that speed.

Anyone who needs to play considerable amounts during the game. It’s pointless having a technically gifted player if he can’t spend more than thirty seconds on the ice at any one time.

How long he is able to play effectively before tiring.

Big centers who have the main aim to drive to the net and make life as hard as possible for the goaltender; and defensemen who need to move those big centers.

How physically strong he is.

Ideally you’ll find players who have a good balance amongst these attributes.

### 9.2. Mental

Ideally you’ll want every one of your players to be mentally strong. If your players have high mental attributes you’re on the right road to success – you’ll have a team of determined and committed players who will give their all for the team, whilst having a nice balance of flair and grit.

The mental attributes section looks like this:

<table>
<thead>
<tr>
<th>Mental</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggression</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Anticipation</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>Bravery</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Creativity</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Determination</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Flair</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Influence</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Teamwork</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>Work Rate</td>
<td>16</td>
<td></td>
</tr>
</tbody>
</table>

The attributes are explained in some detail:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For?</th>
<th>Description</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Description</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggression</td>
<td>The majority of players. Aggression is a big part of hockey, and without it some players will be lost on the ice, but an overly high aggression may cause problems on the ice.</td>
<td>How aggressively he behaves towards other players.</td>
</tr>
<tr>
<td>Anticipation</td>
<td>Top six forwards/top four d-men. If these key players anticipate situations quickly they can make plays happen.</td>
<td>How well he anticipates what is about to happen on the ice, i.e. reading the play.</td>
</tr>
<tr>
<td>Bravery</td>
<td>That player you want out there when the going gets tough.</td>
<td>How brave he is when playing, as indicated by things like his willingness to go into the corners after the puck despite the risk of being hit or his willingness to block shots with his body.</td>
</tr>
<tr>
<td>Creativity</td>
<td>Forwards in general, but mostly centers; offensive defensemen.</td>
<td>How he is at recognizing teammates in potentially good scoring position and make things happen for his team.</td>
</tr>
<tr>
<td>Determination</td>
<td>Everyone. A team united to reach the same common goal will be more likely to reach it if they're all committed to the cause.</td>
<td>How determined he is to win.</td>
</tr>
<tr>
<td>Flair</td>
<td>Your franchise player. Each team would love to have a player with so much flair it’s frightening. It’s generally a case of finding/developing one to build your team around.</td>
<td>How likely the player is to show off and try the unexpected – how exciting he is, essentially.</td>
</tr>
<tr>
<td>Influence</td>
<td>The player who will lead the team and wear the captain's 'C' on his jersey, and players who would be potential 'A' or future 'C' wearers.</td>
<td>How well a player leads by example, and how much they affect the team in a positive way.</td>
</tr>
<tr>
<td>Teamwork</td>
<td>A majority of players if you want your team to play as a cohesive unit, and not like certain collections of highly paid individuals.</td>
<td>How good he is at playing for the team rather than for himself.</td>
</tr>
<tr>
<td>Work Rate</td>
<td>Everyone. It pays off to have everybody work for the cause every shift they take.</td>
<td>How hard he works during a game, as evidenced by how much he regularly does during a shift.</td>
</tr>
</tbody>
</table>

**9.3. Technical**

These attributes are the real meat of the hockey world, where the elite are separated from the very good, and the very good from the rest. These are the playing attributes, where you’ll be looking for consistent ratings across the board for most of your players, and high-end ratings for the elite players on your roster.

The technical attributes section looks like this:
The attributes are explained in some detail:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking</td>
<td>Your checking line, should you choose to have one</td>
<td>How good a player is at shadowing the opponents and preventing them from finishing offensive plays.</td>
</tr>
<tr>
<td>Deflections</td>
<td>Players in the slot looking to get a piece of the puck from long-range shots.</td>
<td>How good a player is at deflecting long-range shots on goal.</td>
</tr>
<tr>
<td>Deking</td>
<td>Wingers generally, but any player who can take past an opponent with skill is handy.</td>
<td>How good a player is at deking opponents using body moves rather than stickhandling.</td>
</tr>
<tr>
<td>Faceoffs</td>
<td>Since your centers will be taking the faceoffs, them.</td>
<td>How good he is at winning faceoffs.</td>
</tr>
<tr>
<td>Hitting</td>
<td>Big defensemen, and tough forwards. A big hit leads by example and gives the whole team a boost.</td>
<td>How good he is at bodychecking opponents.</td>
</tr>
<tr>
<td>Off The Puck</td>
<td>Offensively minded players.</td>
<td>How good he is at moving into good attacking positions, i.e. finding holes in the defense to move through.</td>
</tr>
<tr>
<td>Passing</td>
<td>How accurately the player can complete a pass. Also reflects how easily a pass from this player is received.</td>
<td>Anyone who wants to remain in your plans. Someone who can’t pass is someone who puts your team in danger.</td>
</tr>
<tr>
<td>Pokecheck</td>
<td>Defensemen. They need to break up the offensive rush as quickly as possible.</td>
<td>How well a player can poke the puck away from an opponent using his stick.</td>
</tr>
</tbody>
</table>
Positioning | Anyone with defensive responsibilities, and especially if a team plays a zonal defensive system. | How good he is at staying in a good defensive position.
---|---|---
Slapshot | Players who play the point on powerplays. A top slapshot can be worth its weight in goals. | How good his slapshot is, taking into account release, strength and accuracy.
Stickhandling | Any player who’ll be moving the puck up-ice frequently. | How good a player is at moving and controlling the puck while skating.
Wristshot | Offensive talents with an eye for scoring. | How good his wristshot is, taking into account release, strength and accuracy.

### 9.4. **Goaltending**

Some of the attributes detailed above are also relevant to goaltenders. The goaltending attributes section looks like this:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Useful For?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blocker</td>
<td>All goalies</td>
<td>How good he is at saving shots with his blocker.</td>
</tr>
<tr>
<td>Glove</td>
<td>All goalies</td>
<td>How good he is at saving shots with his glove hand, and how well he holds onto the puck with it.</td>
</tr>
<tr>
<td>Passing</td>
<td>Goalies playing in teams who stress a passing/puck possession game. A goalie acting as a sixth skater with sound passing is an asset.</td>
<td>How well he passes to teammates.</td>
</tr>
</tbody>
</table>
### Poketch
Goalies on teams who may be prone to giving up breakaway situations often.

**How adept he is at making pokecheck saves.**

### Positioning
All goalies

**How positionally sound he is.**

### Rebound Control
Goalies on teams who have defensemen who may be less than adequate at clearing the slot.

**How often he is likely to offer up rebounds – a higher number will result in less rebounds and better control of them when they happen.**

### Recovery
All goalies

**How well he recovers from one/multiple saves or tricky situations.**

### Reflexes
All goalies

**How likely he is to make spectacular saves and react as quickly as possible to all situations.**

### Stickhandling
Goalies playing in teams where the coach allows them to play the puck outside of their crease.

**How well he handles the puck when attempting to play it.**

### 10.0 Drafts

Drafts are massively important in hockey. It’s a guaranteed source of talent for teams to either improve immediately, long-term, or in many cases, both.

For those perhaps new to hockey, the concept of a draft is quite simple. Each team picks in reverse order of the final standings in the previous season (with some minor shuffling about in certain situations). Players are typically selected from junior and younger teams at varying levels of talent, some able to step in and play for the team straight away, some requiring a few years development time.

Some leagues implement a Draft Lottery system. In short, this means teams other than the team finishing last overall have a shot at the top pick. Each qualifying team is given a weighted percentage chance of winning the lottery based on their final ranking position, with the poorest teams given a greater chance of success. Some drafts will also limit how many spots a team can move up by winning the draft.

### 10.1 Scouting the Draft

As an addendum to scouting in general, outlined in Section 8.0, scouting the annual draft is about as important as anything you’ll do as General Manager. As already mentioned, the draft is the lifeblood of your team – future powerhouses are built around players you select in the draft. Solid scouting will make your selections easier and future key players much easier to identify.

Depending on the league (and as such financial restraints), it’s wise to employ as many scouts as your budget allows. If you can afford to employ maybe half a dozen scouts your team will be better for it in the long run. You’ll be able to assign half of them to the draft via the scouting screen (as explained in the aforementioned Section 8.0) and the other half can be used to individually scout players. Scouting the top ranked players (from the World -> Rankings menu) will be of great benefit. These players are ranked because they are generally the best players eligible for the upcoming draft and as such it makes sense to do your homework on them.

Start scouting early, and keep it going throughout the season. If you use the rule of thumb of scouting when each set of rankings (Preliminary, Mid-Season, and Final) are released, you’ll have a wider scope and a more rounded opinion of players and how they’re progressing throughout their draft season. If any of your targeted prospects are playing on a team who will play post-season hockey, make sure you scout them intensively during their playoff
outings. You’ll get a top view on how these guys will perform in pressure situations when the big prizes are on the line. At the end of the day you want to get your selection right – these players could be with your team for a long number of years. For the potential investment you’ll have in them, and what they might bring to your team, it’s definitely worth a little effort when scouting.

10.2. The Draft Screen

When the time comes to actually draft, you will enter the draft screen:

The default view will contain all available players. You can filter down to only those ranked or only those picked, or view the draft order and picks remaining to see who is currently on the clock or who is due to pick in the next few selections, especially useful if you’re looking to trade up or down.

When you are on the clock, you will receive advice from your Head Coach, your Assistant GM, and your Head Scout. They will each recommend a player to select. You can opt to not display their opinions by un-ticking ‘Show Suggestions. To actually select a player for drafting, click the ‘Draft’ button towards the top right so that it becomes depressed, then click the name of the player you wish to take with your selection. You will be asked to confirm your choice.

Some teams like to address needs by drafting players to address holes in the roster. Others like to simply draft the Best Player Available (commonly abbreviated to BPA, hence capitalization), feeling that the holes in the roster may no longer exist by the time the player makes it to the team. Of course, if there’s a player with the talent to step in right away and he falls to your pick, it’s always wise to consider taking him. Draft strategies will also differ from the pro game to the junior ranks; in the latter you will only have the player for a few years before he becomes too old so ideally you’re looking for players who can either make an impact now, or at most two years down the road.
10.3. Fantasy Draft

Eastside Hockey Manager™ also features the Fantasy Draft option. This provides users with the option to start a new game in any league and run a draft of all players in that league, effectively creating random rosters for all teams, only in a standard draft format.

To run a Fantasy Draft, follow the steps to begin a new game, but from the box at the bottom of the ‘Select Leagues’ screen, tick ‘Start with Fantasy Draft’. The game will create as normal, and when complete, you will begin at the Draft Options screen.

The ‘General Options’ menu allows you to configure the basics of the draft. You can choose to use the Database Values (i.e. real life values) for Team Finances and Reputations, or you can choose the Maximum/Average salary level for all teams and to recalculate reputations when the draft is over, as some teams may have ended up better than they would have based on real data. Ticking ‘Include Prospects’ will include team prospects playing outside of the league you’re drafting in, so you can draft their rights.

‘Snaking Draft Order’ means that the order will reverse every other round. So, for example, in the above screenshot, that order would be used in the First Round, and would be reversed for the Second Round, then back to normal for the Third and so on – the team picking 30 in the First Round would also have the 31st Overall Pick and as such the first pick in the Second Round.
The Draft Order is entirely configurable. To move a team, click on them and note they will be selected if highlighted in yellow. Simply then click on the name of the team in the spot you wish to move them to, and the teams will swap positions. If you wish to have a random order, select ‘Randomize Order’ from the left menu bar.

Once you’ve set this up to your requirements, click ‘OK’ and select your team, then proceed to the draft, which is reported in the form of a news item. Drafting is the same as detailed in Section 10.2.

---

### 11.0 Trades and Transactions

Much like the draft, you’ll quickly end up with an idea of how you want to build your team. Unlike the draft however, you can usually go out and acquire a player for your team immediately, via trading or on free agency. The sections below will deal with the heavy details involved in all options.

#### 11.1. Trading

For the benefit of familiarity the majority of this section will use examples from familiar leagues, but as the concept and trade engine is pretty much the same across all leagues that use it, the content is still relevant.

You can initiate a trade in several ways:

- From the Actions area on the team screen – ‘Approach to Trade’
- From the Actions area on a player’s profile – ‘Approach to Trade’
- From the ‘Trade’ dropdown on the Trade Center screen.

Selecting any of them will bring up the trade screen.
The screen is divided into three main parts. The top section is your team, the middle section is the team you’re attempting to trade with, and the lower section is the feedback and information section.

Each team section has the same options. You can add players to a trade by selecting the option, then selecting the empty area in the far left column from the roster screen view. The area will fill with a graphic and a ‘+’ sign, indicating they have been added to the trade. Adding the rights to players in your organization who are unsigned is done in the exact same way from the ‘Add Rights’ option. You can add draft picks from the appropriate option – it presents as a series of dropdown menus. Select the year you wish to add a pick(s) from, and then the pick(s) from the resulting menu.

Once an item has been added to a trade, you have more options.

The first thing to notice is the salary in the header. As the player has been added to the trade, the potential salary as a result of his departure changes, and this is displayed. It will continue to recalculate whenever players are added or removed from trades.

The other options, in order, from left to right:

**Star Rating:** This merely displays how much the team like the player. Five stars indicate they rate him very highly and would want him on the team, whereas one star suggests they have little to no interest in him (there is a zero star
option). It should not be confused with a rating system and you should be aware that attempting to trade like for like on star levels will rarely work. A team may have an interest in a four star player, but they would be very reluctant to get rid of one of their own four star players in return. Yes, it can be used as a starting point in negotiations, but it shouldn’t ever be used as a measure for a deal.

**Remove:** Very simple, clicking the ‘Remove’ will release that item from the trade.

**Lock:** Clicking this will change the icon to a closed lock, indicating that item is locked into the deal. This is particularly useful when you’re trying to acquire/offload a particular player but the deal may require further negotiations around it.

**Untouchable:** Clicking this will change the icon to a red ‘no entry’ style sign. It identifies players/items as untouchable and as such they should not be used in negotiations during a deal. Note that players marked as untouchables within a trade negotiation are not included in the trade itself. This option is just a way of telling the other team not to even think about adding this player to the trade table at any point during the negotiations.

Once you start putting potential deals together, you’ll receive feedback from your Coach and the GM of the team you’re attempting to trade with.

Team needs for the team you’re trading with are listed at the bottom to help you identify what they might be looking for in order to get positive feedback from their GM. Your own Head Coach will evaluate the deal and offer his thoughts on the deal.

To see Team Needs for all teams in your league, select ‘View -> Team Needs’ from the Trade Center screen. From here it becomes easier to identify teams who may be looking for the type of player you’re willing to trade to get a good return. From the same menu, you can view the salary cap status of all teams in your league, enabling you to perhaps target a trade with a team with lots of breathing room, or maybe to take advantage of a team over or perilously close to the cap limit.

To get an idea on what your trade partner thinks about the current offer on the table, click on “Gauge Interest” action button to receive their feedback. Be careful about annoying other GM’s with lopsided offers as their patience in the negotiations might run out.

The important thing to really understand about trading is that it’s not easy. Trading in Eastside Hockey Manager™ can be complex. It can be irritating when teams turn down what you consider to be an unbelievably good offer for a player, but such is life, and when you pull off a spectacular trade, you’ll know you’ve deserved it.

One of the better things to do when trading is to put yourself on the other side of the trade. If you were the recipient of one of your own offers, would you accept it (try not to be too biased here)? Chances are, if you wouldn’t accept it, the AI-managed teams won’t either. Look in detail at the roster of the team you’re trading with. Look at their Team Report to see where they lack depth and/or a quality player. Check out their team needs, and what you can afford to give up. If you can match the criteria they set when outlining their team needs, and can give them something they can use, then you’ll be getting somewhere.
Other things to consider when trading are:

- Salary implications. Are you trying to offload an expensive contract onto a team for a few draft picks without checking that the team can afford it? If so, get ready to be turned down.

- Time of the season. Trying to trade for a team’s best player in the first two months of the season isn’t going to bring much success. Let the league take shape, then after the halfway point, as trade deadline approaches, you can try and make a move for the better players on struggling teams, as they perhaps look to rebuild whilst you make a playoff run. This works the same if you’re the struggling team and want to shed a few players.

- What exactly are you doing to interest the other party? If you’re attempting to fleece them in offering your unwanted guys for their star assets, they’ll know. Be fair to them; offer a balanced trade that benefits both sides. Even be prepared to slightly overpay in a gamble to get the guy you want. If you respect the trade system, the trade system will respect you.

**11.2. Waivers**

The Waiver concept is specific to certain leagues. A player waived is offered around all the other teams in the league for what amounts to no cost; teams simply need to be in the position to afford his contract should they wish to enter a claim. A team might waive a player for many reasons, the most common being to free up roster or salary room. They may have called the player up from a minor league for injury/depth cover, and he may need to pass through waivers to return when he isn’t needed, or any other number of reasons.

Depending on the day a player was waived, the time it takes to ‘clear’ waivers differs, but it’s typically the following day during the week and twice as long if waived at the weekend.

Whilst a player in on waivers he can be assigned to any affiliate team but he cannot be released or traded until he has cleared. If more than one team enter a claim for a waived player, the team with the lowest winning percentage will ‘win’ the player.

All player waiver eligibility can be seen from the Waiver Eligibility screen.

Some players will also be subject to re-entry waivers if you wish to call them up to the main roster from an affiliate. Players with a certain level of experience and a salary above a certain limit will have to pass through the same waiver criteria to join up with the team and as such are eligible to be claimed by any desiring team.

**11.3. Free Agency**

The third major way of building your roster. Every summer, some players in every league will see their contract expire and as such they become Free Agents. They are then free to negotiate with any interested party and sign a contract with any team. As a General Manager, this can be one of the busiest times of the year. Not only will you have had to negotiate deals for players you wish to keep, but you will likely be targeting free agents who will improve your team, and also may be attempting to thrash out deals with holdout players on your own roster.

There are various types of free agents but they are most commonly split between Restricted and Unrestricted. A Restricted Free Agent is still owned by the team in so much as they retain exclusive rights to negotiate improved terms with him and can only lose him if suitably compensated (in the form of draft picks, the number of which are determined by the proposed salary by any interested party). An Unrestricted Free Agent, however, is free to sign wherever he wishes.
Different leagues have different levels of restrictions and it will be worth familiarizing yourself with the intricacies of each country when starting out.

To offer a player a contract, select the option to do so from his Actions menu (‘Approach to Sign’), and you’ll be prompted to offer a contract. Once you’ve set a projected team status for the player, you’ll see the Offer Contract screen:

The player will outline his demands, and it’s then up to you to put together a package the player will accept. In leagues where a salary cap is in place, the relevant information will be displayed for you.

From the options on the left menu bar you also have the option to offer bonuses and contract clauses. Be aware that some leagues place restrictions of the offering of bonuses. The four contract clause options are as follows:

**Player Option Year:** The player has the option to re-up for an additional year at the end of his deal at the same salary as his final contract year.

**Team Option Year:** The team has the option to sign the player for an additional year at the end of his deal at the same salary as his final contract year.

**No Trade Clause:** The player has the right to veto any proposed trade he may be involved in. It is purely up to him if he wishes to move (assuming he is available for trade).

**Two Way Clause:** The player will earn a very small percentage of his salary if he is assigned to a minor league affiliate. This should not be mistaken for a clause that allows a player to move freely between the two leagues. You have the option to adjust the wage percentage used in the two way contract.

Free Agency is a definitely proven way to add players to a team in order to make them a contender. With the right financial management you should be able to enter free agency every offseason with money to spend to improve your team. However, be aware that excessive spending can not only result in a roster unfamiliar with each other and will need time to gel, but it could be severely financially restricting down the road if you hand out contracts escalating in
value as the years pass. Building a team through drafting, developing, and some fine and considered free agency is a tried and tested method and should be followed where possible.

### 11.4. Arbitration

Inevitably, there will be occasions where a team and a player can’t agree on contract negotiations and reach a stalemate. At this point, the player has the option of taking the team to arbitration during the offseason. A third party assessor will decide upon a contract reflecting their opinion and valuation of the player based on his previous season and contracts of other similar players. You will be notified of the decision by news item, and you then have the option to either sign the player to his one year contract as awarded by the arbitrators, or to walk away from it and allow the player to become an Unrestricted Free Agent.

### 12.0 Finances

As General Manager, you have a firm responsibility to ensure the financial security of your team is maintained. In the modern hockey area, financial management is a very complex and detailed task – with salary caps, player contracts can be negotiated to the penny. Eastside Hockey Manager™ offers flexibility in its financial options and provides a wealth of information to the General Manager.

#### 12.1. The Finances Screen

The default view for the Finances screen:

![Finance Screen](image)

The upper half of the screen shows basic income and expenditure levels for the last calendar month, and the various totals for your team salary, and also any league levels the team must comply to. The lower half shows a breakdown of all salary on your roster.

The ‘View’ menu offers more options and more information at your disposal. The basic income/expenditure information is broken down across various different areas on the ‘Income and Expenditure’ screen.

The ‘Contract Chart’ screen shows salary commitments on your roster for the next three seasons, allowing you to plan your finances and roster years in advance.

The fourth option, the ‘Salary Cap Chart’, is similar to the ‘Contract Chart’ screen but deals specifically with the salary cap rules enforced by the league your team is in (should they exist).
13.0 Playing Games

Well after all of that, you’ll want to play your games, and with Eastside Hockey Manager™’s 2D Game Engine, you have more control over your players than ever. We’ll get to that in a bit, but first we should run through things in order.

Once you’ve confirmed your lineup and proceed to your game, you’ll end up on the game screen.

The ‘Game View’ should be your main viewpoint on this screen. It will provide you with all the vital statistics live as they update in the lower half of the screen, whilst in the upper half the game will play out in front of your very eyes.

Before dropping the puck, you should take the time to configure the options in the menu bar:

**Zoom**: If you want a closer look at the action, select ‘On’ for a zoomed 2D mode. The alternative is to use a classic 2D mode that allows you to also see up-to-date statistics below the rink.
**Puck Trace**: If you have trouble identifying the puck during play, turning on the puck trace will display an orange glow around the puck, allowing you to pick it up quicker and more easily. If you have no such problem, turning it off will simply display the puck.

**Highlights**: This option allows you to set how much of the action you wish to watch. You can choose to watch the entire game (which requires some spare time), the extended highlights, just the key incidents, or none at all. Each option decreases in action, but the suggested option would be to select the Key incidents choice. You will see all the goals and big chances whilst still getting to see some ‘normal’ play. If you’re a little more ambitious and wish to see how your team play over the length of the game then the Extended or Full options are advisable.

**Clock Speed**: You have three options – Fast, Medium, and Slow. The clock will move at various speeds depending on which one you select.

**Action Speed**: This allows you to set the speed of the 2D action. Varying speed levels will change the speed the events happen, allowing you to slow it right down if you can’t cope with the speed, or speed it right up if you’re finding it too slow.

Once you’ve set everything, you can hit ‘Drop the Puck’ to get the action underway.

The sections under the scoreboard will keep you abreast of absolutely everything whilst the game is going on:

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Boxscore</td>
<td>Displays a traditional boxscore of scorers and assists. Change to ‘Penalties’ from the ‘View’ menu to see all infractions.</td>
</tr>
<tr>
<td>Game View</td>
<td>Shows the hockey action and vital game statistics.</td>
</tr>
<tr>
<td>Shot Chart</td>
<td>Displays a comprehensive shot chart for each team. On the left you see where shots were taken from on the ice, on the right you see where they ended up on net. Red indicates an unsuccessful shot, green indicates a goal. Click on a goal to see a replay of how it was scored.</td>
</tr>
<tr>
<td>Play By Play</td>
<td>Collates the play-by-play text displayed underneath the 2D view into a long detailed report of each period. Change the period you’re viewing from the ‘View’ menu. Click on an incident to see what happened in 2D.</td>
</tr>
<tr>
<td>Ratings</td>
<td>Shows game ratings for every player on both teams. The numbers next to their name indicate any goals or assists logged (in G+A format). Goalies will have Saves/Shots next to their name. The three stars will be indicated at the end of the game in Gold, Silver, and Bronze.</td>
</tr>
<tr>
<td>Home Stats</td>
<td>Comprehensive game stats for the home team.</td>
</tr>
<tr>
<td>Away Stats</td>
<td>Comprehensive game stats for the home team</td>
</tr>
<tr>
<td>Scores</td>
<td>Scores from around the league (and other leagues if you have them selected and there are games scheduled). Scorers are listed and their numbers displayed in G+A format.</td>
</tr>
<tr>
<td>Home Tactics</td>
<td>View the home team’s tactics. If you are at home, you will be able to make changes from here, If not, you will be able to view the opponent’s lines only.</td>
</tr>
<tr>
<td>Away Tactics</td>
<td>View the away team’s tactics. If you are on the road, you will be able to make changes from here, If not, you will be able to view the opponent’s lines only.</td>
</tr>
</tbody>
</table>

Once the game is over you can revisit the game screen by clicking on the boxscore from the league schedule screen or the scoreline from your roster schedule screen. You can now revisit games whenever you like (to a limit, based on the number of games stored set in the Preferences) and view goals, penalties, and incidents by clicking on either the score graphic in the boxscore view or the time of the incident on the play-by-play screen.

Replays of goals and other incidents can only be viewed from games already completed by accessing their boxscore page. 2D replays are not available while you are still coaching or viewing the game.

When viewing action again you have a further set of controls over the action:

**Play/Pause:** Start and stop the action.

**Options:** From here you can rewind incidents to the beginning of the segment, and control the speed. ‘Speed x 1.0’ is standard speed, the other options are either three-quarters or half slower or double speed.

**Goals and Penalties:** Change the incident you’re viewing from the dropdown of all choices.

You can also save the boxscore down to an HTML file from the ‘Export’ menu that looks like this example.
These can be uploaded to various websites as standard for use in online leagues and the like, adding to the realism and overall feel of being immersed in the game.

14.0 Statistics

Eastside Hockey Manager™ features a wealth of statistics and numbers.
A table explaining all of the Player Statistics follows.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Statistic</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>GP</td>
<td>Games Played</td>
<td>Total games played</td>
</tr>
<tr>
<td>G</td>
<td>Goals</td>
<td>Total goals scored</td>
</tr>
<tr>
<td>A</td>
<td>Assists</td>
<td>Total assists provided</td>
</tr>
<tr>
<td>P</td>
<td>Points</td>
<td>Total points scored. (Goals + Assists = Points)</td>
</tr>
<tr>
<td>+/-</td>
<td>Plus/Minus</td>
<td>+1 is awarded to a player if he is on the ice when his team scores a goal (exc. Powerplay goals). –1 is awarded to a player if he is on the ice when his team concedes a goal (exc. Powerplay goals). A higher rating generally means the player is strong all over the ice and contributes effectively on offense whilst playing a very sound defensive game.</td>
</tr>
<tr>
<td>PIM</td>
<td>Penalty Minutes</td>
<td>Total penalty minutes taken.</td>
</tr>
<tr>
<td>SOG</td>
<td>Shots on Goal</td>
<td>Total shots taken on target.</td>
</tr>
<tr>
<td>Sh %</td>
<td>Shooting Percentage</td>
<td>Percentage of successful shots. (SOG/G = Sh %)</td>
</tr>
<tr>
<td>ATOI</td>
<td>Average Time On Ice</td>
<td>The average amount of time a player spends on the ice in a game. As a rule, players with 25:00+ should be considered true workhorses. (Total Minutes Played/Games = ATOI)</td>
</tr>
<tr>
<td>Av R</td>
<td>Average Rating</td>
<td>Each player is given a rating at the end of each game on a 1-10 scale, 1 being awful with 10 being a First Star candidate. This stat averages all ratings and ranks players by their performances. A higher Average Rating suggests a consistently high performing player. (Total Combined Game Ratings/GP = Av R)</td>
</tr>
<tr>
<td>FS</td>
<td>First Star awards</td>
<td>Total number of times a player has been named First Star, the best player on the ice in a game.</td>
</tr>
<tr>
<td>PPG</td>
<td>Powerplay Goals</td>
<td>Total Powerplay goals scored.</td>
</tr>
<tr>
<td>PPa</td>
<td>Powerplay Assists</td>
<td>Total Powerplay assists provided.</td>
</tr>
<tr>
<td>PpP</td>
<td>Powerplay Points</td>
<td>Total Powerplay points scored (PPg + PPa = PpP)</td>
</tr>
<tr>
<td>APPT</td>
<td>Average Powerplay Time on Ice</td>
<td>Average number of minutes spent on the ice in powerplay situations. (Total Time on Ice/Total PP Time on Ice = APPT)</td>
</tr>
<tr>
<td>SHg</td>
<td>Shorthanded Goals</td>
<td>Total Shorthanded goals scored.</td>
</tr>
<tr>
<td>SHa</td>
<td>Shorthanded Assists</td>
<td>Total Shorthanded assists provided.</td>
</tr>
<tr>
<td>SHp</td>
<td>Shorthanded Points</td>
<td>Total Shorthanded points scored (PPg + PPa = PpP)</td>
</tr>
<tr>
<td>APKT</td>
<td>Average Penalty Kill Time on Ice</td>
<td>Average number of minutes spent on the ice in shorthanded situations. (Total Time on Ice/Total PK Time on Ice = APKT)</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>GWG</td>
<td>Game Winning Goals</td>
<td>Total Game Winning Goals scored. A goal is deemed game-winning if it is the first dividing goal in a scoreline. In a 3-2 win, the 3rd goal is the GWG. In a 6-1 win, the 2nd goal is the GWG as it is deemed to separate the 1-1 scoreline.</td>
</tr>
<tr>
<td>GT</td>
<td>Game Tying Goals</td>
<td>Total goals scored that tie a game. The game does not need to finish a tie, the goal simply has to tie the game at any point.</td>
</tr>
<tr>
<td>FG</td>
<td>First Goals</td>
<td>Total opening goals in a game scored.</td>
</tr>
<tr>
<td>HT</td>
<td>Hits</td>
<td>Total hits on an opponent.</td>
</tr>
<tr>
<td>GA</td>
<td>Giveaways</td>
<td>Total number of instances a player turns the puck over to the opposition.</td>
</tr>
<tr>
<td>TA</td>
<td>Takeaways</td>
<td>Total number of instances a player takes the puck from an opponent.</td>
</tr>
<tr>
<td>SB</td>
<td>Shots Blocked</td>
<td>Total shots blocked. The shot does not need to be on target.</td>
</tr>
<tr>
<td>FO %</td>
<td>Faceoff Percentage</td>
<td>Percentage of faceoffs won. (Total Faceoffs/Faceoffs won = FO%). Generally anything above 50% is desirable.</td>
</tr>
<tr>
<td>2</td>
<td>2 minute minor penalties</td>
<td>Total number of two-minute infractions taken.</td>
</tr>
<tr>
<td>5</td>
<td>5 minute major penalties</td>
<td>Total number of five-minute major penalties taken (including fighting majors).</td>
</tr>
<tr>
<td>M</td>
<td>Misconduct penalties</td>
<td>Total number of ten-minute misconduct penalties taken.</td>
</tr>
<tr>
<td>GM</td>
<td>Game Misconduct penalties</td>
<td>Total Game Misconducts taken (a player is dismissed from the game if he takes a GM).</td>
</tr>
<tr>
<td>FI</td>
<td>Fights</td>
<td>Total fights participated in.</td>
</tr>
<tr>
<td>FW</td>
<td>Fights Won</td>
<td>Total fights won.</td>
</tr>
</tbody>
</table>

### 15.0 Troubleshooting

For assistance on any troubleshooting matters you may require, visit our website [http://www.sigames.com](http://www.sigames.com) and the community forums at [http://community.sigames.com](http://community.sigames.com).